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Introduction

Welcome to The Analyst for WindowsTM. This package provides the following features:
-fully automatic price retrieval system
-powerful charting and analysis functions
-automatically updating portfolio management facilities
-share price imager

If you have any questions or comments regarding this package, please contact : 
WinStock Software
10 Jewry St
Winchester
SO23 8RZ        UK

Telephone :        (UK) 01962 715557      
Fax : (UK) 01962 863516      
E-mail : winstock@compuserve.com
Browse : http://www.winstock.co.uk

See Also    : 
Starting a new session
A sample session
Commands



Starting a new session

To begin a new session, double-click on the Analyst icon located in the Analyst folder. 

When the program has finished loading press "ENTER" or select the portfolio manager icon
 from the toolbar. The Portfolio Manager will be displayed. 

To display a portfolio, double-click on any name in the portfolio list. The companies 
contained in this portfolio are now listed. To view a chart, double-click on any company 
name. 

For further guidance, press "HELP".

See Also    : A sample session



Commands and Navigation

The Analyst conforms to all normal windows conventions. It is Microsoft Office compatible, 
and follows the same rules as applications such as Word for Windows and Excel. The Analyst 
is mouse driven and uses the following commands extensively.

Drag and Drop 
The Analyst is an object oriented program. Every item on the screen is an object that can be 
moved, manipulated or clicked on. To compare two price plots in the same chart, simply drag
a title from any listing onto a chart and drop. The two plots will appear together. Drag and 
drop works the same way for building portfolios, moving trend lines, zooming in on a chart 
and so on.
To drag an object, position the mouse pointer over the object. Press and hold down the left 
mouse button. Move the object to its destination and release.

Point and Click 
To examine a chart in detail, position the mouse pointer and click. The date and price at that
point are instantly displayed in the status bar.

Click and pick 
To avoid the need to continually hunt for the correct commands, menus are built into the 
screen objects. Click the right mouse button on a chart to change the font, for example, or 
on a trend line to change its colour.
Portfolio lists can be manipulated or converted to valuation summaries, transactions can be 
added, cash accounts maintained etc. by clicking the right mouse button over a share list.

Double-Click 
A graph of any share may be drawn by double-clicking on the share name itself.

The toolbar provides single step access to the most common functions within The Analyst. 
The menu system gives you full access to The Analyst and help is always available on 
screen.



Charting

Charts allow us to visualise the price data held on the system and give a quick indication of 
trends. Generally, the simplest way to produce a chart is to double-click on a name.

General
Producing a chart

Chart Properties
Overlay Curves High Low Closing
Linear Japanese Candlesticks
Logarithmic Printing
Time Scale (Zooming) Refresh
Price Scaling Font
Remove

Read Values
Price and Date Percentage Change

Overlays
Comparisons Best Fit Line
Moving Averages User Defined Trend Lines
Stop-Loss Fibonacci Fan Lines

Curve Properties
Colour Delete

Line Properties
Colour Delete
Coding Move

Analysis

Charts and portfolios may be subjected to a variety of analytical techniques. 

Select a graph and choose from the analysis selector or analysis menu.

Select a portfolio and choose movers, alarms or price image from the Analysis menu.

Analysis Selector

Analysis Menu





Analysis Menu



Analysis Selector



Analysis Selector

Select a graph and choose one of the following from the analysis selector. 

MACD (Moving Average Convergence/Divergence)
Meisels 
Momentum 
MA (Moving Average)
OBOS (Overbought/Oversold)
RSI (Relative Strength Indicator)
Stochastic 
Stop-Loss



Movers

This function calculates the percentage price movement of all shares in a portfolio over a 
selected time period. Shares are then ranked in order and displayed.

-Select a portfolio.
-From the Analysis menu choose Movers. Then select:

Winners (1 day)
Losers (1 day)

Percentage price movement since the last trading day
Winners (period)
Losers (period)

Percentage price movement over the number of trading day selected

Note:
"Winners" displays largest positive movers first.
"Losers" displays largest negative movers first.



Price Alarm

Price alarms cause the system to compare the price of any share against high and low limits 
that you impose. These may be used to alert you to buying or selling opportunities. Any 
number of alarms can be set, the system will track them all.

-Alarms will be checked for all items in a portfolio as the portfolio is opened. 
-Check all alarms currently set in the entire system by choosing Alarms, Check All from
the Analysis menu. 
-Alternatively, if you are connected to an online feed, such as teletext, you may select 
Auto Alarm Checking from the Options menu. All alarms will be checked on a regular 
basis (4 times per hour).

See Also :        
Setting an Alarm
Alarm Report
Automatic Alarm Checking



Setting an Alarm

Alarms may be set for any share in any client portfolio. (See Portfolio Management). Position 
the mouse pointer over the share name and click on the right hand mouse button. From the 
popup menu select Alarms then Set Alarms. Key in the high and low alarm values. 
The last and next buttons allow you to rapidly set alarms for other members of the current 
portfolio.    
Use the report button to display a report of all alarms that have been activated since the 
start of the session.

See Also :        
Overview
Alarm Report
Automatic Alarm Checking



Alarm Report

Whenever an alarm has been activated, or crossed, the alarm icon  will appear in the 
toolbar.
Press the alarm icon to view the alarm report. Press again to hide the report.
The alarm report lists the share name, portfolio, price, alarm and a comment about the 
alarm.
Position the mouse pointer over this report and click to access a popup menu. This allows 
you to:    

-Sort the alarm report by name or portfolio
-Check all alarms set in the system
-Delete all entries from the alarm report

 
See Also :        

Overview
Setting an Alarm
Automatic Alarm Checking



Automatic Alarm Checking

This facility is useful when you are connected to an online feed, such as teletext.

To ensure that alarms are continuously monitored select Auto Alarm Checking from the 
Options menu. All alarms will be checked on a regular basis (4 times per hour).

Indicators:
As soon as the first alarm of the session is activated, the alarm icon  appears in the 
toolbar. Press this icon to view the alarm report. Each time an alarm is triggered, the icon 
will flash. Some of these flashes will represent the same share at the same price triggering 
the same alarm. An audible beep will be heard only when: 

-a share price crosses an alarm for the first time in a session or 
-a share price movement occurs after an alarm has already been crossed. 

The alarm report records these events.

See Also :        
Overview
Setting an Alarm
Alarm Report



Momentum

Momentum compares the price on a given date with the price one period ago. Any period 
length may be selected but choosing the natural cycle length from observation of the base 
chart is a good start.

Momentum displays the price line's ability to continue its trend    

Method : 
To draw the Momentum plot on a new analysis chart, select an active chart (click on an 
existing chart or see Producing a chart) then

-choose Momentum from the Analysis Selector.
A dialog box will appear. Pick the desired period. Click on New Chart and press OK.
(Note: The first analysis plot is always drawn on a new chart). 
 
To overlay the Momentum plot on an existing analysis chart, select that chart, then 

-choose Momentum from the Analysis Selector.
A dialog box will appear. Pick the desired period and press OK. 

A parallel Momentum chart is drawn beneath the base chart. Scaling and resizing either 
chart is reflected in the other so that both may be easily compared. Use Refresh to realign 
the charts at any time.

See Also :        
Analysis Types



MACD - Moving Average Convergence/Divergence

MACD compares two moving average curves. When the curve cross the zero axis into the 
positive region, a buy signal is given. When the curve cross the zero axis into the negative 
region, a sell signal is given. The two periods selected for the moving averages are critical. 
Choosing the natural cycle length from observation of the base chart for one, and a half or a 
quarter of this length for the other gives good results.

Method : 
To draw the MACD plot on a new analysis chart, select an active chart (click on an 
existing chart or see Producing a chart) then

-choose MACD from the Analysis Selector.
A dialog box will appear. Pick the desired periods and the type of moving average 
(simple or exponential) to use. Click on New Chart and press OK.
(Note: The first analysis plot is always drawn on a new chart). 
 
To overlay the MACD plot on an existing analysis chart, select that chart, then 

-choose MACD from the Analysis Selector.
A dialog box will appear. Pick the desired periods and the type of moving average 
(simple or exponential) to use. Press OK. 

A parallel MACD chart is drawn beneath the base chart. Scaling and resizing either chart is 
reflected in the other so that both may be easily compared. Use Refresh to realign the charts
at any time.

See Also :        
Analysis Types



RSI - Relative Strength Indicator

RSI is a momentum indicator formed by comparing the average price rises and falls over a 
chosen period. RSI displays the instrument's strength relative to itself. Overbought situations
occur when the resultant curve rises above 70 and oversold is indicated by a fall below 30.
The moving period that is generally recommended is 14 days, although periods from 5 to 25 
days can be used for shorter or longer term trading.

Method : 
To draw the RSI plot on a new analysis chart, select an active chart (click on an existing 
chart or see Producing a chart) then

-choose RSI from the Analysis Selector.
A dialog box will appear. Pick the desired period. Click on New Chart and press OK.
(Note: The first analysis plot is always drawn on a new chart). 
 
To overlay the RSI plot on an existing analysis chart, select that chart, then 

-choose RSI from the Analysis Selector.
A dialog box will appear. Pick the desired period and press OK. 
 

A parallel RSI chart is drawn beneath the base chart. Scaling and resizing either chart is 
reflected in the other so that both may be easily compared. Use Refresh to realign the charts
at any time.

See Also :        
Analysis Types



OBOS - Overbought/Oversold

OBOS compares the price on a given date with the moving average on the same date. The 
OBOS chart oscillates about the zero axis with the peaks and troughs showing overbought 
and oversold situations. Looking at how this chart appears in the past will help to identify 
developing overbought and oversold situations. Any period may be selected but if there is 
an observable cycle in the price line, then this period should be tried.

Method : 
To draw the OBOS    plot on a new analysis chart, select an active chart (click on an 
existing chart or see Producing a chart) then

-choose OBOS    from the Analysis Selector.
A dialog box will appear. Pick the desired period and select the type of moving average 
to use (simple or exponential). Click on New Chart and press OK.
(Note: The first analysis plot is always drawn on a new chart). 
 
To overlay the OBOS    plot on an existing analysis chart, select that chart, then 

-choose OBOS    from the Analysis Selector.
A dialog box will appear. Pick the desired period and select the type of moving average 
to use (simple or exponential). Press OK. 

A parallel OBOS chart is drawn beneath the base chart. Scaling and resizing either chart is 
reflected in the other so that both may be easily compared. Use Refresh to realign the charts
at any time.

See Also :        
Analysis Types



Meisels

Meisels is an overbought/oversold indicator which counts the difference between the number
of daily rises and falls over the selected period. Any period may be chosen but a period of 10
days is normal for shares with overbought being set at +6 and oversold at -6. 

Method : 
To draw the Meisels plot on a new analysis chart, select an active chart (click on an 
existing chart or see Producing a chart) then

-choose Meisels from the Analysis Selector.
A dialog box will appear. Pick the desired period. Click on New Chart and press OK.
(Note: The first analysis plot is always drawn on a new chart). 
 
To overlay the Meisels plot on an existing analysis chart, select that chart, then 

-choose Meisels from the Analysis Selector.
A dialog box will appear. Pick the desired period and press OK. 

The Meisels plot will be drawn beneath the base chart. Scaling and resizing either chart is 
reflected in the other so that both may be easily compared. Use Refresh to realign the charts
at any time. 

See Also :        
Analysis Types



Stochastic

The Stochastic curve uses a probability function as an overbought/oversold indicator. It is 
based on the observation that prices accumulate near peaks or troughs. The Stochastic 
curve charts the ratio of the price range over a given period to the closing price at the end 
of that period. 

Any period length may be selected but choosing the natural cycle length from observation of
the base chart should give reasonable results. This analysis works best if there is an obvious 
cycle in the price line.

Method : 
To draw the Stochastic plot on a new analysis chart, select an active chart (click on an 
existing chart or see Producing a chart) then

-choose Stochastic from the Analysis Selector.
A dialog box will appear. Pick the desired period. Click on New Chart and press OK.
(Note: The first analysis plot is always drawn on a new chart). 
 
To overlay the Stochastic plot on an existing analysis chart, select that chart, then 

-choose Stochastic from the Analysis Selector.
A dialog box will appear. Pick the desired period and press OK. 
 

A parallel Stochastic chart is drawn beneath the base chart. Scaling and resizing either chart
is reflected in the other so that both may be easily compared. Use Refresh to realign the 
charts at any time.

See Also :        
Analysis Types



Analysis Menu

Select a graph and choose from Analysis menu:
Lines:

User Defined Trend Lines
Best Fit Lines
Fibonacci Fan Lines

Overlay Curves:
Stop-Loss
Moving Averages
Comparisons - overlay other stocks, indices, etc. on the same graph

Display:
High Low Closing
Japanese Candlesticks
Linear
Logarithmic

Click anywhere on the chart to read:
Price and Date
Percentage Change

Select a portfolio and choose from the Analysis menu:
Movers
Alarms
Price Image



Imaging - Overview

What is imaging?
Imaging is a method of displaying a large amount of data on screen quickly and in a way 
that is easy to understand. Share price movement is transformed into a colour picture and 
displayed as a strip across the screen. Like a graph, time increases to the right. Unlike a 
graph, however, the y-axis is replaced by colour with shades of blue and red representing 
movement up and down, (green is no change). Many images can be displayed together on 
the screen or rapidly scrolled through.

                

Why use imaging?
Your system can hold price histories for several thousand shares. Hunting through graphs for
a steady mover or a breakout situation can be a slow process. Colour images give you an 
overview and an immediate comparison between shares. Double clicking on any price strip 
produces a chart and gives you access to all the traditional analysis techniques.

See Also :        
Producing an Image
Interpreting the Image



Interpreting the Image

Colour images of price movements are similar to relief maps. Once the colours are 
associated with price change, a third dimension becomes apparent.

The image shown above represents 6 months of price data for each of the companies listed. 
(One row per company). A 7-day moving average was applied to smooth out the price 
variations. Blue represents prices rising, red falling and green unchanged. The darker the 
colour the greater the change. (See : Image Colours).
 
Interpretation : BankIrlnd
BankIrlnd shows a steady rise until early August and then a gradual fall to the beginning of 
September. It climbs more strongly to mid October and, after a short period of consolidation,
it rises sharply in mid November. To verify the interpretation, a double-click on the BankIrlnd 
row produces a chart.

                

Portfolios of shares or sector listings may be scanned quickly using colour imaging. Any 
interesting or disturbing developments may be viewed in more detail by double-clicking on 
the instrument in question from within the image    window.    A chart will immediately be 
drawn giving full access to all normal charting functions.

See Also :        
Imaging - Overview
Producing an Image



Producing an Image

To produce an image, a portfolio listing must first be active (see Selecting a Portfolio).    
1. Select one or more names from the portfolio listing. 

- to select a continuous group:
Position the mouse over the list so the pointer turns into a "north-south"     arrow.

Press down the left mouse button and drag to highlight the required items  
or 
Click on the first instrument then shift-click on the last instrument    

- to select individual instruments:
Click on the first name then control-click on non-adjacent instruments

2. Click on the Image icon  in the toolbar.
3. A dialog box will be displayed with the following choices :

Period
Averaging

4. Choose OK to plot the colour image.

5. From the moment the image starts to build you can 
-Double-click on any row to see a chart
-Drag any name into a portfolio list
-Scroll through the image
-or continue with other tasks

6. To stop a plot, select STOP then YES from the menu.
7. If a continuation image plot is needed to hold all the companies selected, its name will be 
"...NAME". The first plot will be called "NAME...".
8. Image plots are "resource intensive". The number that can be drawn depends upon the 
power of your computer. 

See Also : 
Imaging - Overview
Interpreting the Image



The Spectral Display dialog box:



Image Colours

The colours used in an image are red, green and blue. 

Red indicates that prices are decreasing. 
Green indicates that price are unchanged.
Blue indicates that prices are rising. 

Lighter shades of red and blue indicate slowly varying prices, whereas darker shades 
indicate faster moving prices.

The lightest red and blue represent 0.5% price change in one day. The darkest shades 
represent greater than 2.5% daily price change. Other shades represent intermediate values
in steps of 0.5%.



Read Base Curve

This option is used with the other graphing functions Price and Date and Percentage Change.

If the Option menu item "Read Base Curve" is ticked then the value of the base curve on 
the selected date is used to determine the price and the percentage change for the status 
bar display. Otherwise the price at the current position of the mouse pointer is used.

Select this option to quickly read values from the base curve of the current chart. Deselect 
this option to accurately read values from trend lines or overlay curves.



Transaction

The transaction form is used to add or edit transaction details.

Select buy, sell, dividend or script dividend. Then fill in details of date (using the 
day/month/year format), quantity of shares, price and charges. 

The Date defaults to today's date and the Price to the latest price available. You may, of 
course, change either.
Press the  button and the program will fill in the price corresponding to the date 
you have entered.

Note:
If you leave charges blank, the program will estimate the fee charged. The total paid or 
received will be based on this estimate.
If you supply a value for charges, the total will use this value.
If you fill in the total paid or received but leave charges blank, charges will be calculated 
from:

Total - (Price * Quantity)

See Also:
New Transactions
Edit Transactions



Transactions

New Transactions
Edit Transactions
Delete Transactions



Portfolio Management

Portfolios allow you to collect groups of shares together. You may display a portfolio either as
a listing of, say, names and prices, or expand it into a detailed transaction summary., simply
by clicking the toolbar Portfolio button 

Portfolios
Viewing a Portfolio Deleting a Portfolio
Creating a New Portfolio System and Portfolio Groups

Shares
Adding Instruments Removing Instruments

Transactions
Viewing Transactions Edit Transactions
New Transactions Delete Transactions

Cash Account
Working with cash accounts

Utilities
Edit Price Histories

Analysis
Chart Image
Price Alarms

List Properties
Price, Change, % Change, Last Price, High, Low, Time, Date



System and Portfolio Groups

System Groups are a function of Teletext and the way in which data is stored and 
retrieved. They cannot be edited but they can be deleted. If deleted, they will be 
automatically restored when Teletext capture is resumed. They cannot be expanded to show 
transaction summaries.

Portfolio Groups are completely under user control. They can be created, edited and 
deleted. They can be expanded to show full transaction summaries and transactions may be 
added, edited and deleted.

See Also:
Viewing a Portfolio
Creating a New Portfolio
Deleting a Portfolio



Utilities

Price data comes into your system from external sources. Occasionally there may be an 
error in the data causing a spike on a chart. Or a share name may change so data from the 
old name will need splicing to the new name. Or the share may split....
Utilities are provided to work around these eventualities.

Split
Premium
Splice
Spike fix
Edit Price Histories



Price Updating & Maintenance

Price updating can be performed in several ways:
Teletext
Diskette
Internet Update
Prestel Updating
Manual Input

Maintaining the price archive is sometimes necessary. The Analystprovides a set of tools to 
manipulate the data:

Utilities

When a data set is no longer needed in the archive, see:
Deleting Data Sets 



Internet Updating

The e-mail data feed is sent out each evening. It consists of closing prices for 2,700 shares, 
with highs and lows for the top 500 companies. Currencies, world indices, some gilts and 
commodities are also included. 

Once you have received the file, copy it to the Analyst folder. The Analyst will quickly add its
contents to your archives. 

Ensure that the Option/Update Method is set to Internet then
Select Update from the File menu and press OK or
Select the toolbar update icon  and press OK.

To keep your price archives up to date, you will need to use the e-mail data file attachments 
in chronological order to update the program.

General instructions for handling the e-mail data file:
There are many e-mail programs on the market. The following general instuctions should be 
noted.

The price data file is sent as an attachment to an e-mail message. Its name is INET.UUE. 
Most e-mail programs will retain this name. For those that do not you will need to rename 
the file to INET.UUE. Copy the file to the Analyst folder.

For windows 95 users :
To check that the file has been saved correctly, open the windows explorer and check that 
INET.UUE is present in the ANALYST folder. This file should be about 41kb in size and its type 
should be "UUE file". If the explorer is not currently displaying size and type information, 
select View / Details from the explorer menu.
If you cannot find "INET.UUE", check the explorer View / Option menu. The item labelled 
"Hide MS-DOS file extensions for file types that are registered" should not be ticked. Look for
"INET.UUE" again.

For windows 3.x users :
To check that the file has been saved correctly, open the file manager and check that 
INET.UUE is present in the ANALYST directory. This file should be about 41kb in size. If the file
manager is not currently displaying size and type information, select View / All File Details 
from the file manager menu.

Finally, perform the update. Open the Analyst, check that Option / Update Method is set to 
Internet Data Source. Select File / Update to perform the update. The update should take 
between 10 seconds and 2 minutes depending on your computer's specification.

BACKUPS:
To safeguard your data you need to make regular backups. Price histories can be replaced, 
but your portfolios are unique. To backup your portfolio data, use the file manager or 
windows explorer to copy the contents of the ANALYST\GROUP folder to a diskette.

Always perform this backup regularly and before any modifications or 
upgrades to your Analyst software.



Prestel Updating

Updating from Prestel Citifeed or Citifeed plus requires a special version of the Analyst 
program.

Citifeed supplies the closing prices for all companies on the London Stock Exchange. Citifeed
plus supplies the OCHLV (open, close, high, low and volume) data. 

The main features of the Prestel version of the Analyst program are :

Data is retrieved from Prestel via the Analysts built in downloader. A single click from the 
Analyst program dials, downloads, unzips and archives the data.
OCHLV data is available from 6.30 pm.
3,200 companies are covered.
Volume pips are displayed in the price charts.
Open, close, high and low prices are used in the candlestick plots.
OCHLV is displayed in the price histories.
SEAQ codes, as used by the stock market, are used to archive the data.
Full company names are displayed in portfolios and the toolbar.
Multiple daily updates can be performed with one command. The Analyst knows when 
your last update was and will download the correct number of data files.
Prestel keep 20 days of data on their system.

This upgrade is not compatible with the internet or teletext versions of the Analyst program 
as SEAQ codes are used to archive the data. The Prestel version of Analyst comes complete 
with price archives, charting, analysis and portfolio management.

Prestel can be contacted on 0171 591 9008.

See Also
Retreiving Prestel Price Information
Identifying your modem and port number
Select phone settings
Choosing a Prestel update mode
New SEAQ code list



Prestel - Retreiving Price Information

Retrieving price information
Retrieving price information from Prestel is fully controlled by the Analyst program. 
The Analyst provides various options to control dialling, downloading and updating to give 
you maximum flexibility.

Before downloading for the first time, you will need to perform three tasks:
Identify your modem and port number
Select phone settings
Choosing a Prestel update mode

See Also
Prestel Updating - General
New SEAQ code list



Prestel - Identifying your modem and port number

From the Analyst menu select Comms/Modem. The default modem, Hayes compatible 
28,800 works in most cases. Select the port number that your modem is using (1,2,3 or 4) 
and press ok. 
If the program reports an error, try selecting a Hayes compatible option with a speed closer 
to that of your own modem or look for your modem make and model    in the displayed 
dialog box and again press ok.

See Also
Prestel Updating - General
Retreiving Prestel Price Information
Select phone settings
Choosing a Prestel update mode
New SEAQ code list



Prestel - Select phone settings

From the Analyst menu select Comms/Phone Settings to display the phone book. The phone 
number of Prestel Citiservice is already in place (0171 589 3202). You will need to enter the 
following details.

Baud rate : Select a speed slightly greater than that of your modem. 
Type in your Prestel ID and password
Ensure that Closing Mid Price or OCHLV is selected with an 'x'

The settings for parity (N), data bits (8), stop bits (1) and handshaking (both) should not 
need to be changed.

See Also
Prestel Updating - General
Retreiving Prestel Price Information
Identifying your modem and port number
Choosing a Prestel update mode
New SEAQ code list



Prestel - Choose an update mode

The Analyst can be updated in a number of ways. 
Timed 

Set the time of the update using Comms / Time of Auto Update.
The Analyst will dial Prestel at a pre-set time, retrieve all data files since the last 
download then update the price archives. 

 Automatic 
Set the update mode using Comms / Prestel Update Mode / Automatic
Selecting File / Update causes the Analyst to dial, retrieve all data files since the last 
download then update the price archives.

Semi-automatic 
Set the update mode using Comms / Prestel Update Mode / Semi-Automatic
Select File / Update and input the number of daily files to be downloaded. Pressing ok 
causes the Analyst to dial, retrieve this number of data files then update the price 
archives.

Manual 
Set the update mode using Comms / Prestel Update Mode / Manual.
The manual mode separates the dialling and updating functions. To connect to Prestel 
choose Comms / Connect. The program will dial and give your password and ID. You are 
then free to manually select files from the Prestel bulletin board. When you have finished
and are off-line, update the Analyst price archives manually by selecting File / Update. 
Highlight the first file to be processed and press ok.
If there are earlier files in the same directory The Analyst will display a warning.
If there are later files in the same directory, The Analyst will ask whether you want to 
process these as well.

Processed files will be renamed *.BU.

See Also
Prestel Updating - General
Retreiving Prestel Price Information
Identifying your modem and port number
Select phone settings
New SEAQ code list

 



Prestel - New SEAQ code list

From time to time a new SEAQ code to share name list is produced by Prestel. This file is 
important as it links the SEAQ codes in the daily price files to the full share name. The new 
file will account for recent name changes, new companies etc.
To incorporate the new list into the program follow the instructions below:

If the Prestel Update Mode is set to Automatic or Semi-Automatic 
Select File / New SEAQ Code List.

If the Prestel Update Mode is set to Manual 
Download the file manually from Prestel using the Comms / Connect function. (The 
file is called seaqcode.csv and is "sorted by code") . From The Analyst's menu select 
File / New SEAQ Code List. Highlight the file and press OK.

See Also
Prestel Updating - General
Retreiving Prestel Price Information
Identifying your modem and port number
Select phone settings
Choosing a Prestel update mode

 



Import

The import function allows you to bring historic price (and volume) data from external files 
into the Analyst's price archives. 

Import file layout
The data to be imported should be arranged in a tabular format with each file containing 
data for one share. The name of the data file is assumed to be the name of the imported 
company. For example, the file called BTR.CSV might contain the columns Date and Close 
(this file holds the historic date and closing price data for BTR).
The arrangement and type of data columns can vary and the Analyst must be setup 
accordingly. Different layouts can be saved and recalled for future use. 

The Import Command
To import data select file / datasets / import.
Locate the file containing the data to be imported. (*.txt, *.csv, *.asc etc.) and press ok.
The first few lines of the files will be displayed to help in setting up the import layout.
If you know that the current setup is correct press import (see below).
Otherwise select setup (see below).

Setting Up the Import Layout
From the Import Data Format dialog box:
1.      Choose an existing setup (select a name from the save/restore area) or create a new 

setup (type a new name into the save/restore area).
2. Choose the column heading order. Move the cursor over the column heading number 1, 

click on the down arrow and select from name, date, open, close, high, low, volume and 
unused. Repeat for other columns in the import file.

3. Select the date format, ddmmmyy, excel etc
4. Select the seperator type, comma, space or tab.
5. Save the setup and press ok.

Import
From the View File dialog box select the import button. If the import is successful the 
company title and the starting date of the data are displayed. Change the company name if 
required. Press ok. The historic data is then displayed. Press ok
The new company is added to the archives in the manual group.
To locate this company, use the archive browser (File / Browse) or the portfolio manager (File
/ Portfolio /    Manual).
  



Scanner

The scanner module is available as an add-on function to users of the Analyst. 

The object of the scanner is to identify profitable investment situations by highlighting 
companies whose share prices are performing according to specified criteria.
This allows you to display, for example, a list of all companies

whose share price has risen by 50% over the last 6 months but has fallen by 5% in the 
last week.

or
whose 20 day moving average has risen above the 9 day moving average in the last 10 
days and the share price is greater than 100p.

etc.

The various tasks that can be performed by the scanner are listed below and any number of 
these tasks can be combined into a single scan. This scan description can then be saved and
recalled for future use. Scans are designed to be appplied to groups of shares eg. Prestel, 
teletext3000, your own portfolio. The result of a scan can be displayed alphabetically or 
sorted by any element of the scan such as price, RSI, MA etc.

Scanner tasks
Price [greater or less] than x.
Price has changed by x% over y days.
The [highest or lowest] price in the last x days has occurred in the last y days.
Stop loss: the x% stop loss [long or short] starting on a given date [has or has not] been
breached in the last y days.
Moving average: the x day ma has [risen above, remained above, remained below or 
fallen below] the y day ma in the last z days.
RSI: the x day RSI is [above or below] a given value and [rising or falling].
OBOS the x day OBOS is [above or below] a given value and [rising or falling].
MACD the x,y day MACD is [above or below] a given value and [rising or falling].

Square brackets [ ] denote choices.

  



Teletext - Capture & Updating

The Analyst will automatically capture data for all companies it finds on Teletext. If a new 
company is encountered, a new dataset is automatically started. No user action is required.

Price data is first captured by the program and then, at the end of the day's trading, added
to the archives.

Capturing Teletext data is controlled by a "Loading List". Pressing the toolbar icon switches 
teletext capture on or off.

 Teletext Capture is OFF. Press to turn on.
 Teletext Capture is ON. Press to turn off.

Adding the data to the archives is totally automatic. 
Ensure that the Option/Update Method is set to Teletext then
Select Update from the File menu and press OK or
Select the toolbar update icon and press OK.

Alternatively, use the teletext timer to perform the update.

Teletext Operation
Overview 
Teletext Cards
Functions
Automatic Operation
Loading Lists
Suggested Teletext Capture Routine

Updating
Adding Data to the Archives



Automatic Operation

Teletext Status at Startup
From the Options menu choose Teletext at Startup.
Selecting this option switches teletext capture ON or OFF when the program is started.
The current status of Teletext at Startup is shown by the menu itself.
Note : Selecting this option will change it.

Timed Final Save
From the Options menu choose Time of Final Save.
Use the up and down arrows in the dialog box to select the time to save.
Select "Disable Timer" to stop the timer from activating.
Select "Save" to update the Analyst at the selected time.
Select "Save and close Analyst" to update and then close the Analyst.
Select "Save and close Windows" to update and then close the Analyst and Windows.

The final save is important as it adds all the data collected today to the archives.

See Also
Adding Data to the Archives.



Manual Data Input

Editing Price Histories
Manual Price Updating
Creating Data Sets Manually



Adding Data to the Archives 

Data is captured to memory while the program is running. At the end of the trading day the 
captured data must be transferred to the main archives. This may be accomplished 
automatically or manually:

Automatically
From the Options menu choose Time of Final Save.
Use the up and down arrows in the dialog box to select the time to save.
Select "Disable Timer" to stop the timer from activating.
Select "Save" to update the Analyst at the selected time.
Select "Save and close Analyst" to update and then close the Analyst.
Select "Save and close Windows" to update and then close the Analyst and Windows.
The final save will be carried out at the selected time in all future sessions until changed 
by you. 

Manually
-Use the toolbar icon  or

-From the File menu choose Update then press OK.

You only have to update the main archives once a day, after the day's trading data has been
collected.      

Note:
1. Data captured to memory during the day is periodically backed up to disk for safety. 
2. There is no problem (or advantage) if the data is transferred to the main archives more 
than once in the same day.

See Also
Teletext Overview
Teletext Cards
Teletext Functions
Teletext Loading Lists
Suggested Teletext Capture Routine



Suggested Teletext Capture Routine

Using the loading list 2000.lst for about 20 minutes will collect all the Channel 4 teletext 
3000 data.
Change to 22x-52x.lst to collect the remainder of the share information supplied by 
Channel 4 and BBC2. Foreign exchanges, indexes, commodities and gilts are also captured 
by 22x-52x.lst

Daily.lst combines the two routines mentioned above, may be left to run in the background 
and ensures that all data is collected.

To have a complete record of highs and lows throughout the day, capture may be left to run 
unobtrusively in the background.

More felxibility is provided by using the "Set Schedule" button to switch between page lists 
at certain times of the day.

See Also
Teletext Overview
Teletext Cards
Teletext Functions
Automatic Operation
Teletext Loading Lists
Adding Data to the Archives



Teletext Cards    -    Microtext and WinTV (Hauppauge)

Microtext
The Microtext teletext card fits into any ISA slot in your computer. The TV aerial will then 
plug into the back of the card. All software required to tune and run this card is included with
the Analyst system. The Analyst will capture up to 4 pages of teletext data at a time from 
the Microtext card. This card will detect any errors in the teletext signal and works well over 
a wide range of signal strengths. The Microtext card works with Windows 3.x and Windows 
95

WinTV
The Analyst works with all TV-teletext cards produced by Hauppauge. This discussion refers 
to the WinTV card.

The WinTV card requires a free PCI slot in your computer and has a TV aerial socket in its 
back plain. The software to tune and run this card is supplied with the card and will only 
work with Windows 95.

After installing and tuning the WinTV card following the manufacturer's instructions, you will 
need to perform the following checks before starting the Analyst program.

1.    Check that the channels are arranged    in the correct order (BBC1, BBC2, ITV and CH4).
Do this from the Hauppauge TV program by selecting Configure / Channels. If the order is 
not correct, make a list of the channel names and (frequency) numbers eg.Ch 4 - 65; 
BBC2 - 62 etc. Now edit the channel list so that the channel names and their 
corresponding frequency numbers are in the correct order. Select close and exit the TV 
program.

2.    Open the VTPlus program that is provided with the Wintv card. From the Options menu 
select "Change TV Stations / Setup". Each channel in the dialogue box should have the 
"use in VTPlus" selection ticked. 

3.    Open the Analyst program and from the Options menu set Teletext Card to WinTV 406. 
4.    From the Teletext menu choose Select Page List. Set the page list to "Daily" to capture all

data. The end of day update can be performed manually (File / Update) or by timer 
(Options / Time of Final Save).

5.    Do not close the VTPlus program when collecting data with the Analyst. 
 

See Also
Teletext Overview
Teletext Functions
Automatic Operation
Teletext Loading Lists
Adding Data to the Archives



Select/Change Teletext Loading List

To change the loading list 
-From the Teletext menu choose "Select Page List"
-Select the required list from the display and 
-Press OK



Teletext Functions

Teletext functions are available through the Teletext and Options menu.

Capture
To start or stop a    teletext session :

-From the Teletext menu choose Capture or
-Select the Teletext icon from the toolbar
 Teletext Capture is OFF. Press to turn on.
 Teletext Capture is ON. Press to turn off.

When capture is on, the capture option in the teletext menu is ticked and the teletext icon is 
empty.

View Page
To view the current teletext page:

-From the Teletext menu select View Page and press OK
To view a different teletext page:

-From the Teletext menu select View Page.
-Select a channel and page number and press OK

Hold Page
To hold the current teletext page:

-From the Teletext menu select Hold

Multiple page capture (Available when using a Microtext teletext card)
To update from 4 teletext pages simultaneously:

-From the Teletext menu toggle Multiple Page Capture to ON
This option is available when you are using a Microtext teletext card for data acquisition. You
should normally set this option to ON. If you notice a drain on your computers resources, for 
example the computer slows down appreciably during data capture, toggle Multiple Page 
Capture to OFF. The program will still update from teletext but only one page at a time.

Capture New Share Names
To allow the Analyst to automatically capture any new share names that it finds on teletext:

-From the Options menu toggle Capture New Share Names to ON

You should leave this option ON if    
-you are running a Microtext card with error checking ON    

You should turn this option OFF if    
-you are running a Microtext card with error checking OFF or 
-you have a WinTV card installed    (this card does not have error checking)

With Capture New Share Names OFF, spurious share names will be prevented from entering 
the price archives. You should periodically (once every week or two) turn Capture New Share 
Names ON for about half an hour. Do this when reception is good and any shares new to 
teletext will be introduced to your system. Price capture to these new shares now start.

See Also
Teletext Overview
Teletext Cards
Automatic Operation
Teletext Loading Lists
Suggested Teletext Capture Routine
Adding Data to the Archives



Teletext Loading Lists

Teletext loading lists control the TV channel and page numbers combinations that are to be 
processed by the Analyst.

Select/Change Loading List
To change the loading list 

-From the Teletext menu choose Select Page List
-Select the required list from the display and 
-Press OK

More felxibility is provided by using the "Set Schedule" button to switch between page lists 
at certain times of the day.

Edit/Create/Delete Loading List
To manipulate the loading lists

-From the Teletext menu choose Edit Page List
-Press the Lists button displayed at the bottom of the editor

Select one of the following actions:
Edit Loading List 

- Select a loading list and press OK.
Delete Loading List 

- Select a loading list and press delete, confirm, then press OK.
Create Loading List 

- Press New and type in the name of the new list.

When creating or editing a list, manipulate individual lines as follows:
Add a new line:

-Select a Channel, Page, Sub-page and template
-Press Add

Edit a line:
-Select the line to be edited
-Adjust Channel, Page, Sub-page and template
-Press Change

Delete a line:
-Select the line to be deleted
-Press Delete

Note:
When selecting a template, ensure that the description matches the data you expect to 
receive on that page.

See Also
Teletext Overview
Teletext Cards
Teletext Functions
Automatic Operation
Suggested Teletext Capture Routine
Adding Data to the Archives



Teletext Overview

Teletext Card Installation
Teletext operation requires that:

-A Teletext receiver card is installed in your computer (follow manufacturer's instructions)
-The card is connected to a suitable aerial
-The manufacturer's software is loaded and 
-The card is tuned. 

From this point on The Analyst takes over. 

Tuning
Some teletext cards must be tuned from within The Analyst. If this is the case there will be 
an option "Tune" available in the Teletext menu. 

Select this option and press OK. 
Select Tune, Auto, UK then OK.
When "Signal found, Save to channel" is illuminated press OK.
After all channels have been located press Cancel then OK.

This procedure only needs to be followed once.

Teletext Operation
Deciphering teletext data is controlled through the use of Loading Lists. Loading lists match 
the channel, page and subpage to the data layout. For example, on Channel 4 Page 533, all 
subpages use layout TText2000.
Various loading lists are included with the system but they may be edited and added to with 
care. Give any new page-lists meaningful names as a memory aid.

Teletext Layout : Channel4 and BBC2
BBC 1, BBC 2 and Channel 4 all provide financial data in the UK. BBC2 and Channel 4 
broadcast share price data updated every 15-20 minutes on the UK's top 500 companies. 
Channel 4 and BBC1 also supply closing price data on approximately 2,700 UK companies 
updated 3-4 times a day. Other financial data is available on teletext including currencies, 
world indices, gilts etc.

See Also
Teletext Functions
Teletext Cards
Automatic Operation
Suggested Teletext Capture Routine
Adding Data to the Archives



Updating Data Sets by Diskette

If you have chosen to use our diskette data service, you will receive diskettes periodically. 
The update diskette contains prices which will be added to your archive data. These prices 
do not replace your existing data. The process of updating several thousand datasets is 
fast and simple.

Check that Option/Update Method is set to Diskette.
Insert the diskette
Select Update from the File menu or 
Use the toolbar icon 

Press OK.



Exporting Data Sets 

This function allows the exporting of up to five years of price data to a nominated file. Four 
different formats are available: 

ASCII Text format (*.ASC)
CSV Text format, variables separated by commas (*.TXT)
Excel CSV format with Excel readable date (*.CSV)
Lotus CSV format with Lotus readable date (*.PRN)

To export a data set 

1. From the File menu, choose DataSets/Export.
2. Type in the name of the instrument. 
3. Select the corresponding title displayed in the list and press OK.
4. A save file dialog box will be displayed. Either accept the suggested file name and 
destination or enter your own. Press OK.



Hiding Data Sets 

Hide is used to remove any datasets from display but not from the archives.

Use this function    in case one instrument has more than one title from different sources. 
Teletext feeds from different channels will often send information on the same company but 
with slightly different names. Use Hide to prevent the display of these repeats.

To hide a data set 

1. From the File menu, choose DataSets/Hide.
2. Type in the name of the instrument. 
3. Select the corresponding title displayed in the list; "hide" appears next to the title.

To unhide a dataset

4. Repeat steps 1 and 2 above.
5. Select the title again. The "hide" flag will disappear.



Deleting Data Sets 

To mark a data set for deletion 

1. From the File menu, choose DataSets/Delete.
2. Type in the name of the instrument. 
3. Select the corresponding title displayed in the list; an "x" appears in the delete column.
4. The data set will be erased during the next update.

To remove the mark for deletion

5. Repeat steps 1 and 2 above.
6. Select the title again. The "x" will disappear.
7. The data set will not now be erased during the next update.



Creating Data Sets Manually 

To create a data set manually:

1. From the File menu, choose DataSets/Manual.
2. A Manual Entry dialog box appears.
3. Type in the name of the new instrument and it's starting date. 
4. Scroll through the price list and input values manually.

See Also
Editing Price Histories Manually



Producing a chart

Charts are produced by 
- double-clicking on any instrument listed in a portfolio, the archive browser or image.
or
- selecting any instrument listed in a portfolio, the archive browser or image and 
choosing the graph icon  from the toolbar.



Remove From Chart

Remove Overlays
Click the right mouse button over a chart and select Remove/Overlays from the popup 
menu. All curves except the base curve will be removed from the selected chart.

Remove Lines
Click the right mouse button over a chart and select Remove/Lines from the popup menu. All
lines will be removed from the selected chart.

Remove Analysis
Click the right mouse button over a chart and select Remove/Analysis from the popup menu.
All analysis charts removed leaving the base chart alone.

Remove All
Click the right mouse button over a chart and select Remove/All from the popup menu. All 
curves, lines and analysis charts will be removed and the time scale will be set to maximum.
Only the original instrument price curve will be left. 

Zoom Out
Click the right mouse button over a chart and select Zoom Out from the popup menu. The 
time scale will be reset to maximum for the chart/analysis combination.



Time Scaling

Charts are initially drawn using all available data. 

To zoom in, drag one of the long yellow sliders from the edge of the chart to a new start or 
end date and release. The graph will be re-drawn using the new time scale.
 
Note : The left hand slider defines the new starting date; the right hand slider defines the 
new ending date.
                                

                        
                                                                                                          
To zoom out, drag one of the small yellow markers on the x-axis to the new start or end 
date and release.

Note : When either x-axis slider is selected, the complete time scale available for this 
instrument is displayed. This is to assist in picking a new date.



Price Scaling

Price scaling is automatic and is readjusted whenever a new time scale is selected or new 
curves are added.



Overlay Curves

The first curve drawn on a chart is known as the Base Curve. Other curves may be added to 
any chart, for example, comparisons showing the relative movements of two or more stocks,
moving average curves, stop-loss indicators, best fit lines, etc.

Curves may be deleted from any chart by selecting the curve with the right mouse button.
A popup menu will appear. Choose delete to remove the curve.



Linear

When a chart is first drawn it is displayed in a linear format. In other words, equal vertical    
distances on the chart represent equal price changes. 

To toggle to and from a linear display select the chart and 
-press the toolbar icon  or
-from the Analysis menu, choose Log/Lin 



Logarithmic

In a logarithmic display, equal vertical    distances on the chart represent equal percentage 
changes.

To toggle to and from a logarithmic display select the chart and 
-choose the toolbar icon  or
-from the Analysis menu, choose Log/Lin



Japanese Candlesticks

Japanese Candlesticks are an extension of the bar (high-low-closing) type of display. They 
show high, low, open and close for each point. The body of the candle shows the open and 
close levels. If the body is red, the price is falling, if blue it is rising. The high and low for the 
day extends as a single line above and below the body. 
There will be no bar on one side or the other of the candle if the open or close is equal to the
high or low for the day.

To toggle to and from the candlestick display, select the chart and 
-choose the toolbar candlestick icon  or

-from the Analysis menu, choose Japanese Candlesticks    

Note : Not all price data sets are supplied with high and low price information. The 
Candlestick display is not available on logarithmic charts.
 



High-Low-Closing

The high-low-closing display adds vertical lines to the closing price curve for a particular 
instrument. The top of each daily vertical line represents the high price for the day; the 
bottom of the line represents the low price.

To toggle to and from the high-low-closing display, select the chart and 
-choose the toolbar icon  or
-from the Analysis menu, choose High/Low 

Note : Not all price data sets are supplied with high and low price information. The high-low-
closing display is not available on logarithmic charts.
 



Font

To set the font used in chart displays, position the mouse pointer over the axes or chart 
background and click the right mouse button. Select Font from the popup menu then choose
the desired Font Name and Size.

Note : The selected font will apply to all charts on screen and printer.



Printer Line Width

To set the line width used to draw plot curves, position the mouse pointer over the chart 
background and click the right mouse button. Select Printer LineWidth from the popup menu
and choose the desired width setting (1 to 4).

Note : This setting only affects output to the printer.



Printing

To change the selected printer 
-from the File menu, choose Printer Setup 
-choose the correct printer and press OK

To print a chart, select an active chart (click on an existing chart or see Producing a chart) 
then

-choose the Print icon  from the toolbar or
-from the File menu, choose Print and press OK 

See Also : Font,    Printer Line Width



Refresh

To re-draw a chart, position the mouse pointer over the chart background and click the right 
mouse button. Select Refresh from the popup menu.



Comparison Overlay 

Any instrument may be overlaid onto any chart. 

To produce a comparison overlay, select an active chart (click on an existing chart or see 
Producing a chart).
Select the instrument to be used in the overlay from any portfolio, archive browse list or 
colour image. Using the left mouse button, drag the instrument onto the chart and 
release. A popup menu will appear displaying the choices Rebased, Relative and Absolute.

Rebased : The overlay curve is scaled so that it crosses the base curve at the start of 
the display. The same scaling factor is applied to the entire overlay curve.
 
Relative : The base curve is divided by the overlay curve on a daily basis. The 
resulting curve is scaled so that it crosses the base curve at the start of the display.

Absolute : The overlay curve is displayed over the base curve without scaling.

Select an option and the overlay will be drawn.

Note : Dragging from a portfolio list
The mouse pointer changes as it moves over a portfolio list. 

 When it points to the top or bottom of a share name it is a single headed arrow. Click now 
to drag the share name to a chart or to another portfolio. 
 When pointing to the middle of a share name the mouse pointer is a double headed arrow. 

Click and drag over the list to highlight the instruments to be processed by the data imager.



Moving Averages

Moving Averages are used to smooth price movements and show underlying trends more 
clearly. Comparisons between moving average curves of differing periods are often used to 
give buy or sell signals.

Method : 
Select an active chart (click on an existing chart or see Producing a chart) then

-choose  from the toolbar or
-from the Analysis menu, choose Moving Average 

A dialog box appears with the following options :

Type : 
Simple : The average price over the selected period is used to calculate each point of 
the curve. 
Exponential : Greater weight is assigned to more recent data. This type of curve shows
turning points more quickly than the simple average.

Period : 
Any value may be chosen provided there is sufficient data to cover the period.

Position :
Lagged : Each moving average point is plotted at the end of the period.
Centred : Each moving average point is plotted at the centre of the period.

Channel :
None : No channel
Simple : A channel will be drawn on either side of the moving average curve a constant
percentage above and below. Choose values from 2% to 5% although any size may be 
selected. Channels are used as a double check before buying and selling. Letting the 
closing price curve pass right through the channel will filter out minor price fluctuations.
Bollinger Bands : Bollinger bands are drawn as an envelope around a moving average 
curve. They may be selected to be drawn a set number of standard deviations above 
and below the moving average.
The standard deviation is recalculated for each point of the plot and covers the same 
period as selected for the moving average. The bands do not remain a fixed distance 
from the moving average curve as simple percentage bands do. When the bollinger 
bands squeeze together a change in price is imminent.
Try with values of 1 to 2 standard deviations although any value may be specified.



Bollinger Bands

Bollinger bands are drawn as an envelope around a moving average curve. They may be 
selected to be drawn a set number of standard deviations above and below the moving 
average.
The standard deviation is recalculated for each point of the plot and covers the same period 
as selected for the moving average. The bands do not remain a fixed distance from the 
moving average curve as simple percentage bands do. When the bollinger bands squeeze 
together a change in price is imminent.
Try with values of 1 to 2 standard deviations although any value may be specified.



Templates

Command : 
File/Chart Template/Load
File/Chart Template/Save

Templates allow you to save your entire analysis techniques for use on another instrument 
at a later stage. Templates will store all overlays, lines, analysis charts, time scales etc. 
under a single name. 

Save :
To save a template, activate the chart/analysis combination. Select File/Chart Template/Save.
Pick a name for the template and press OK.

Load :
To use a previously saved template, activate a chart of the instrument to which the template
is to be applied. Select File/Chart Template/Load and choose a template from the list.



Saving and loading charts

Saving Charts
Whenever a chart is unloaded, you are prompted to save your work. At the end of a session 
you may elect to save all, some or no charts. Only charts which have been altered during 
the session may be saved.

Loading charts
Whenever a chart is loaded it will restore the settings at the time of the previous save. 



Moving Average Type (Simple or Exponential)

Simple : The average price over the selected period is used to calculate each point of the 
curve. 
Exponential : Greater weight is assigned to more recent data. This type of curve shows 
turning points more quickly than the simple average.



Stop-Loss

The Stop-Loss function defines a level at which to buy or sell after a price reversal.

Method : 
Select an active chart (click on an existing chart or see Producing a chart) then

-choose the Stop-Loss icon  from the toolbar or
-from the Analysis menu, choose Stop-Loss 

A dialog box appears with the following options :

Percentage :
Select the percentage change from a recent high or low. This defines the level at which 
to draw the stop-loss curve.

Direction :
Long or short

Finally press OK then click on starting date for the stop-loss calculation.



Best Fit Line

Method : 
Select an active chart (click on an existing chart or see Producing a chart) then

-choose the Best Fit Line symbol  from the toolbar or
-from the Analysis menu, choose Best Fit 

1. Position the cursor on the date at which the line is to start. 
2. Press the left hand mouse button and drag to the end date. 
3. An outline box will appear to help in date selection. 
4. Release the mouse button and the trend line will be drawn. 
5. A channel will be drawn 1 standard deviation above and below the main line.

See Also : Move, Colour, Delete, Coding



Fan Lines

Method : 
Select an active chart (click on an existing chart or see Producing a chart) then 

-from the Analysis Menu, choose Fibonacci Fan Lines or
-from the Analysis Selector, choose Fan Lines

1. Position the cursor on the starting point for the line.
2. Press the left hand mouse button and drag to the end position. 
3. A line is drawn. 
4. Release the mouse button to fix the base line and draw the fan lines. 

Fan lines act as support and resistance lines for stock trends. Draw the base line along an 
existing trend. The fan lines will be drawn at angles a set ratio of the base line angle. (The 
ratios used are 0.382, 0.5 and 0.618)

See Also : Move, Colour, Delete, Coding



User Defined Trend Lines

Method : 
Select an active chart (click on an existing chart or see Producing a chart) then 

-choose the Free Form Line symbol  from the toolbar or
-from the Analysis menu, choose Line 

1. Position the cursor on the starting point for the line.
2. Press the left hand mouse button and drag to the end position. 
3. A line is drawn. 
4. Release the mouse button to fix the line. 

See Also : Move, Colour, Delete, Coding



Colour - Line

To change the default colour of a line drawn on a chart : 
1. Position the mouse pointer over the line.
2. Press the right mouse button; a popup menu will appear.
3. Select Colour from this menu.
4. Choose from the basic colours displayed or define and select a custom colour.
5. Press OK.
6. The line will be re-drawn in the selected colour.



Coding

To change the default coding of a line drawn on a chart : 
1. Position the mouse pointer over the line.
2. Press the right mouse button; a popup menu will appear.
3. Select Coding from this menu.
4. Choose from the displayed list.
5. Press OK.
6. The line will be re-drawn using the selected coding.



Delete - Line

To delete a line drawn on a chart : 
1. Position the mouse pointer over the line.
2. Press the right mouse button; a popup menu will appear.
3. Select Delete from this menu.
4. Press OK.
5. The line will be deleted.

When the selected line is a member of a Fan Line or Regression group, the option to delete 
the set is given.



Move - Line

Lines drawn on a chart may be moved parallel to their existing position or rotated about 
either end.

To move a line parallel to its existing position : 
1. Position the mouse pointer over the centre section of the line.
2. Press the left mouse button.
3. Drag the line to its new location and drop.

To rotate a line : 
1. Position the mouse pointer close to the end of the line.
2. Press the left mouse button.
3. Drag this end of the line to its new location and drop.



Colour - Curves

To change the default colour of a curve : 
1. Position the mouse pointer over the curve.
2. Press the right mouse button; a popup menu will appear.
3. Select Colour from this menu.
4. Choose from the basic colours displayed or define and select a custom colour.
5. Press OK.
6. The curve will be re-drawn in the selected colour.



Delete - Curve

To delete a curve : 
1. Position the mouse pointer over the curve.
2. Press the right mouse button; a popup menu will appear.
3. Select Delete from this menu.
4. Press OK.
5. The curve will be deleted.

When the selected curve is a member of a moving average group eg. a bollinger band or 
percentage band, the option to delete the set is given.



Price and Date

To determine the price and date of the base curve at any point simply move the mouse 
pointer to that point and click. The date and price will be displayed in the status bar.

Note : If the Option menu item Read Base Curve is ticked then the value of the base curve 
on the selected date is used in the status bar display. Otherwise the price at the current 
position of the mouse pointer is used.



Percentage Change

To determine the time interval, percentage price change and absolute price change between
any two points on the base curve, move the mouse pointer to the starting point and press 
the left mouse button. Drag the mouse pointer to the end point and release. The time 
interval, percentage change and absolute change will be continuously updated in the status 
bar as the mouse pointer is dragged. The final values will remain in the status bar at the end
of the operation.

Note : If the Option menu item Read Base Curve is ticked then the value of the base curve 
on the selected date is used to calculate the status bar display. Otherwise the price at the 
current position of the mouse pointer is used.



The Status Bar is located at the bottom of the main program window and is used to relay 
information and messages. For example, the date and price at a particular point on a chart.



Split
This function is used to correct prices prior to a 

-Script Issue (or Capitalisation)    
or

-Sub-Division or Consolidation



Sub-division or Consolidation

A company may decide to combine several shares together (the opposite of a Script Issue).   
As there will be fewer shares around, the share price will rise. New shares are distributed to 
shareholders in proportion to their original holdings.

Example:
One new shares is issued to replace every 10 shares held on 27 Sept 1995.
If the shares were priced at 10p each on 26 Sept 1995 
then on 27 Sept 1995, the shares will be priced at 100p each.
Therefore the share price has risen from 10p to 100p.
All prices prior to 27 Sept 1995 must by multiplied by 10 to account for the consolidation.

1. From the File menu, choose Prices. 
2. Type in the name of the instrument. 
3. Select the corresponding title displayed in the list and press OK.
4. Choose Split then "Sub-Div or Consolidation".
5. Select the final date to be altered by scrolling through the displayed price listing. 
(Example: 26 Sept 1995)
6. Input details of the consolidation and press OK. (Example: 1 for 10)
7. Save Changes to update the archive or
8. Cancel to undo the changes.



Script Issue or Capitalisation

A company effects a Script Issue by Capitalising part of its reserves. In other words, part of a
company's cash reserves are moved to share capital on the balance sheet allowing it to 
issue more shares. As the Script Issue does not raise any new money and there are now 
more shares around, the share price falls. New shares are distributed to shareholders in 
proportion to their original holdings.

Example:
Three new shares are issued for every 2 shares held on 27 Sept 1995 (the shareholder now 
has 5 shares).
If the shares were priced at 100p each on 26 Sept 1995 then 2 shares cost 200p.
On 27 Sept 1995, 5 shares are now valued at 200p or 40p each.
Therefore the share price has dropped from 100p to 40p.
All prices prior to 27 Sept 1995 must by multiplied by 0.4 to account for the script.

1. From the File menu, choose Prices. 
2. Type in the name of the instrument. 
3. Select the corresponding title displayed in the list and press OK.
4. Select Split then "Capitalisation".
5. Find the final date to be altered by scrolling through the displayed price listing. (Example: 
26 Sept 1995)
6. Input details of the split and press OK. (Example: 3 for 2)
7. Save Changes to update the archive or
8. Cancel to undo the changes.



Premium

This function is used to adjust prices for partly paid shares.

Select the share name with the right mouse button. Choose Price History from the popup 
menu.

or
From the File menu, choose Prices. 
Type the name of the instrument into the Find box.
Select the corresponding title displayed in the list and press OK.

1. Select Premium.
2. Select the final date to be altered by scrolling through the displayed price listing.
3. Input the amount to be added and press OK.
4. Choose Save Changes to update the archive or
5. Choose Cancel to undo the changes.



Splice

This function is used to splice prices from one data set to the start of another.

1. Ensure that the archive browser is not active
2. From the Utilities menu, choose Splice. 
3. Type the name of the instrument to splice from into the Find box. 
4. Select the corresponding title displayed in the list and press OK.
5. Type in the name of the instrument to splice to into the Find box. 
6. Select the corresponding title displayed in the list and press OK to perform the splice or 
7. Choose Cancel to abort the procedure.

Provided that there is historic data available in the first file the splice will now be carried out.
The first data set will remain unchanged. The historic data will be spliced to the start of the 
second data set. The names of both data sets remain unchanged.



Spike fix

Occasionally an error in the data may find its way into the system and produce a "spike" on 
a price chart. The Spike Fix function is used to look for and repair these spikes.

Select the share name with the right mouse button. Choose Price History from the popup 
menu.

or
From the File menu, choose Prices. 
Type the name of the instrument into the Find box.
Select the corresponding title displayed in the list and press OK.

1. Select Spike Search.
Automatic
2. Select the Auto Fix button or
Manual
3. Input the percentage change to look for or use the default (40%) and press OK.
4. Any spikes found will be displayed for manual correction.
5. Repeat to continue the spike search.
6. Choose Save Changes to update the archive or
7. Choose Cancel to undo the changes.



Popup Menu : A "floating" menu that appears at the mouse pointer offering a choice of 
actions.



Control-Click : Hold down the control key and click with the left mouse button



Shift-Click : Hold down the shift key and click with the left mouse button



Period : Time span before present over which the image is drawn



Averaging is similar to the moving average used on charts. This option smoothes out the 
price fluctuations and enables a clearer interpretation of the image.



Viewing a Portfolio

1. To view a portfolio :
-select the portfolio manager icon  from the toolbar or

-from the File menu, choose Portfolio
The Portfolio Manager is displayed.
2. Select a system or portfolio group. 
3. Double-click or press OK to display the portfolio listing.

See Also : 
Adding Instruments
Removing Instruments
Creating a New Portfolio
Deleting a    Portfolio



Creating a New Portfolio

1. To create a new portfolio :
-select the portfolio manager icon  from the toolbar or

-from the File menu, choose Portfolio
The Portfolio Manager is displayed.
2. Select New and type in the name of the new portfolio. 
3. Press OK and an empty portfolio list box is displayed.

See Also : 
Adding Instruments
Removing Instruments
Selecting a Portfolio
Deleting a    Portfolio
Manual Price Updating



Adding Instruments

To add new instrument titles to a Portfolio listing :

1. Using the left mouse button, drag instrument titles from the archive browser to the 
portfolio box and drop.
2. Instrument titles may be dragged in the same way from other portfolio or group listings.

Note : Dragging from a portfolio list
The mouse pointer changes as it moves over a portfolio list. 

 When it points to the top or bottom of a share name it is a single headed arrow. Click now 
to drag the share name to a chart or to another portfolio. 
 When pointing to the middle of a share name the mouse pointer is a double headed arrow. 

Click and drag over the list to highlight the instruments to be processed by the data imager.

See Also : 
Selecting a Portfolio
Creating a New Portfolio
Removing Instruments



Viewing Transactions 

Open a portfolio and expand it, using the toolbar  button, to show the transaction 
summary

To view all transactions in a particular share, move the mouse pointer over that share and 
press the right mouse button. From the popup menu select Transaction Details.
The transaction detail sheet which appears displays all transactions to date in this share (in 
this portfolio). You may now add new transactions or edit or delete existing transactions. 

See Also :
New Transactions
Edit Transactions
Delete Transactions



New Transactions 

To record details of share purchases and sales, open the transaction detail sheet for the 
share in question.

Select the New Transaction button located at the top right hand side and fill in details, Date, 
Quantity and Price. 

Note:
Charges will be estimated unless a figure is supplied by you, or calculated if you supply the 
total paid or received for the transaction.
The Date defaults to today's date and the Price to the latest price available. You may, of 
course, change either.

Press OK to proceed.

See Also :
Viewing Transactions
Edit Transactions
Delete Transactions



Working with Cash Accounts 

A cash account is automatically maintained for each portfolio. It keeps a running balance of 
cash deposited and withdrawn as well as receipts from dividends and the sale of shares, and
cash used for purchases. 

To view the cash account, activate your portfolio. 
Click the right mouse button over any share to display the popup menu. Select Cash 
Account.
The cash account for this portfolio will now load. 

New cash deposits and withdrawals
To enter cash deposits and withdrawals, press the New Credit/Debit button. 

Edit or delete cash entries
To edit or delete cash transactions, click the mouse on the appropriate deposit or 
withdrawal.
Choose edit or delete from the popup menu.



Edit Transactions 

To change any part of an existing transaction, open the transaction detail sheet for the share
in question.

Position the mouse pointer over the transaction to be altered and press the right mouse 
button. Select Edit from the popup menu and then change any transaction details (Buy/Sell, 
Date, Quantity and Price etc.). 

Press OK to proceed.

See Also :
Viewing Transactions
New Transactions
Delete Transactions



Delete Transactions 

To delete an existing transaction, open the transaction detail sheet for the share in question.

Position the mouse pointer over the transaction to be deleted and press the right mouse 
button. Select Delete from the popup menu. 

Press OK to proceed.

See Also :
Viewing Transactions
New Transactions
Delete Transactions



Calculator                        

Whenever the calculator icon is seen, this may be pressed to retrieve the onscreen 
calculator.



Removing Instruments from a Portfolio

To remove an instrument title from a Portfolio listing :

Select the instrument title to be removed and press delete on the keyboard or 
Right click over the instrument and select delete from the popup menu. 

In the case of customer portfolios an advice is posted that any associated transactions will 
also be removed. Accept by pressing OK or cancel this command.

See Also : 
Selecting a Portfolio
Creating a New Portfolio
Adding Instruments



Chart

To create a chart from a Portfolio listing :

Select the instrument name to be charted. Then:
double-click on the name 

or
click on the name with the right hand mouse button and choose Graph from the popup 
menu

or
choose the graph icon  on the toolbar.

To view charts of other items in the list:
Highlight an instrument name then use the Last  and Next 

 arrows on the toolbar to see successive charts. Using the Next-Last arrows, the previous 
chart will be unloaded before the current one is drawn to prevent a build-up of too many 
open charts. To fix a chart on the screen, use one of the methods outlined above.

See Also : 
Charting



Manual Price Updating

To manually update your shares on a regular basis, activate your portfolio. 

1. Click the right mouse button over the first share to be updated and select Manual Input 
from the popup menu.
2. Input closing, high and low prices and choose Next or Last to proceed directly to 
neighbouring shares. 
3. When finished, press OK. 
4. Repeat the above process for any other portfolios that need updating.
5. To save the new price data to the archives:

Ensure that Options/Update Method is set to manual
Select Update from the file menu and press OK.

See Also : 
Creating Data Sets Manually
Selecting a Portfolio
Creating a New Portfolio



Edit Price Histories 

To add to or edit the price history of any share, first highlight the share with the mouse 
pointer. Any share name appearing in a portfolio listing, the archive browse box or on an 
image plot may be used.

1. Click the right mouse button and select Price History from the popup menu.
2. The Edit Prices dialog box will be displayed.
3. Edit the data (scroll if required)
4. Choose Save Changes to update the archive or
5. Choose Cancel to undo the changes.

Alternative methods:
Toolbar & menu
a. Select the share name then

- select the Edit Prices icon  from the toolbar or
- from the Utilities menu, choose Edit Prices.
The Edit Prices dialog box will be displayed.
Continue from (2) above.

Using the Archive Browser
a. From the File menu, choose Prices. 
b. Type the name of the share into the displayed box. 
c. Select the corresponding title displayed in the list and press OK.
The Edit Prices dialog box will be displayed.
Continue from (2) above.

See Also : 
Manual Price Updating
Creating Data Sets Manually
Selecting a Portfolio
Creating a New Portfolio



Deleting a Portfolio

1. To delete a portfolio :
-select the portfolio manager icon  from the toolbar or

-from the File menu, choose Portfolio 
The Portfolio Manager is displayed.
2. Select    the portfolio. 
3. Press Delete to remove the portfolio.

See Also : 
Selecting a Portfolio
Creating a New Portfolio



Display Portfolio Properties

When a portfolio is first opened it is displayed as a simple listing. Any of the following 
properties may be selected for the display. To view a different property, choose from the 
Display menu:

Price
Most recent price

Change
Price change since the last trading period

% Change
Percentage price change since the last trading period

Last Price
Closing price at the end of the last period

High 
Highest price reached during the current period

Low
Lowest price reached during the current period

Time
Time of broadcast 

Date
Date of most recent trading period

Page Type
Teletext group name

Source
Teletext channel, page and sub-page number

View Portfolio/View List
Change the portfolio display mode



Changing the portfolio display mode

The display mode of a    portfolio may switched between a simple listing of, say, names and 
prices, and a detailed transaction summary in any of the following ways:

-Press the toolbar  button or
-From the Display menu, choose "View List/View Portfolio" or
-Select any item in the portfolio with the right hand mouse button then choose "View 
List/View Portfolio" from the popup menu.
To revert back to the original display, just repeat the process.



Archive Browse

All data that comes into the system is stored in an archive on your hard disk. The archive 
browser is provided to give you full access to it. To use the Archive Browse function :

1. From the File menu, choose Browse .              
      or use the toolbar button. 
2. Start typing the name of the instrument into the "Find" box.
3. All matching titles will be displayed in the list box.
4. Select the correct title from the list. 
5. Choose one of the following actions :

Chart
Edit Prices
Add to portfolio
Create comparison overlay
Display properties

See Also : 
Charting
Edit Price Histories
Adding Instruments
Comparison Overlay
Browse Properties



 To produce a chart from the Archive Browser:

Select any name with the right hand mouse button and choose Graph from the popup 
menu.

or
Highlight a name and Press OK 

or
Double-Click on any name 

To view charts of other items in the list:
Highlight a name then use the Last  and Next 

 arrows from the toolbar



 Edit Prices : To list all price information for an instrument:

Select any name with the right hand mouse button and choose Price History from the 
popup menu.

or
Highlight a name then select the Edit Prices icon  from the toolbar    

or
From the Utilities menu, choose Edit Prices .



 Add to portfolio
Use the left mouse button to drag the title.
Drop onto a portfolio listing to add this instrument to that portfolio.



 Create comparison overlay
Use the left mouse button to drag the title.
Drop onto a chart to create the overlay.



 Display properties : 
To change the property displayed by the archive browser, choose the Display menu then 
select one of the listed properties.



Browse Properties

To change the property displayed by the archive browser, choose the Display menu then 
select one of the listed properties. 

The archive will not contain today's data if you have not yet performed an update. However, 
all charts, price histories and image plots will always include the most recent prices.

Last Archived Price
Latest price held in the archive.

Archive Start Date
Date of first archived price for this instrument

Archive End Date
Date of latest archived price for this instrument

Time span
Time span from first to last archived data.

Page Type
Teletext group name

Source
Teletext channel and page number



Instrument
A financial instrument is any form of equity, index, currency, commodity or gilt etc.



Sample sessions

Making a list of the day's fastest movers
Identifying steady movers
Constructing a share portfolio

See Also    : 
Starting a new session



The Portfolio Manager dialog box:



Making a list of the day's fastest movers

1. Open the portfolio manager:
-select the portfolio manager icon  from the toolbar or

-from the File menu, choose Portfolio

2. Select "Share400" from the system group listing (any portfolio or system group listing 
may be chosen). 
3. Double-click or press OK to display the portfolio listing.
4. From the Analysis menu choose Movers and then Winners(1 day).
5. A list of all movers since the start of the day, ranked in order, is produced within seconds. 



Identifying steady movers

This method may be used to search the archive of several thousand shares and rapidly 
identify upward movers.

Find the movers
1. Open the portfolio manager:

-select the portfolio manager icon  from the toolbar or
-from the File menu, choose Portfolio

2. Select "TText2000" from the system group listing (any portfolio or system group listing 
may be chosen). 
3. Double-click or press OK to display the portfolio listing.
4. From the Analysis menu choose Movers and then Winners(period).
5. When the dialog box appears select or key in the desired period (for example, 90 or 180 
days)
6. A list of all movers over the period, ranked in order, is produced. 

Highlight the winners
7. Produce an image of all shares that have moved by more than 20% :

a. Click the left mouse button on the first share in the list.
b. Scroll down through the list to reach the 20% movement level.
c. Hold down the shift key and click the left mouse button on the share at this level.

Create an Overview
8. Click on the Image icon  in the toolbar.
9. A dialog box will be displayed with the following choices :

Period
Averaging
Select a period of one year with 14 day averaging

10. Choose OK to plot the colour image.



Reading the Image
11. Making a colour image of the price movements is a fast way of displaying a large 
amount of data. Remember that blue represents prices rising, red falling and green 
unchanged. (See : Image Colours). 

What we are looking for, in this example, are companies with predominantly blue images. In 
other words the 14 day moving average is rising. From the time scale we see that the right 
hand side of the chart is the current date. So a patch of blue on the right hand side means a 
currently rising average. 

To check your interpretation, double click on any strip and a graph of that share price will be 
drawn.

Making a new portfolio list will allow you to collect share names by dragging the name from 
the image into the portfolio list.



Constructing a share portfolio

Create a portfolio
1. Create a new portfolio :

-select the portfolio manager icon  from the toolbar or
-from the File menu, choose Portfolio

2. Select New and type in the name of the new portfolio. 
3. Press OK and an empty portfolio list box is displayed.

Start the archive browser.
4. From the File menu, choose Browse or use the toolbar button. 
5. Start typing the name of the instrument into the "Find" box.
6. All matching titles will be displayed in the list box.
7. Use the left mouse button to drag the correct title from the archive list to the portfolio.
8. Repeat for all shares that are to be included.

Filling in the portfolio details
9. Click the right mouse button on any share name in the portfolio. A popup menu will 
appear. Select "View Portfolio" to display the portfolio summary. 
10. The portfolio summary lists:

-Share Name, Price, Holding, Cost, Value, Gain, Unrealised (URL) Gain and % URL Gain 
and calculates the totals of:

-Cost, Value, Gain and Unrealised Gain. 
So far, all the portfolio shows is a list of names and share prices.
11. To fill in the transaction details for a particular share, click the right mouse button on 
that share. From the popup menu choose "Transaction Details" and the Transaction dialog 
box is displayed. Press the "New Transaction" button and fill in the details. (Buy/Sell, date, 
quantity, price and charges). Press OK. To correct a mistake or delete an entry at this stage 
press the right mouse button on the transaction and select Edit or Delete.
12. Repeat for all transactions in this share then press OK to return to the Portfolio Summary.
13. Fill in the transaction details for the remaining shares in the portfolio following steps 11 
and 12. 

Notes
All client details are saved automatically and the entire portfolio is updated whenever new 
prices are received into the system.
There is no limit to the number of transactions per share, shares per portfolio or on the 
number of portfolios that can be held on the system.





How to Order

The Analyst for Windows costs from £79.95 (see price list below). To order a copy and 
receive 2,700 price histories free of charge, either phone, fax or post the following details to 
us. To print out this form select File / Print Topic from the menu above.

Price List and Order Form
The Analyst    for Windows Price Tick

Update Manually or by Diskette    £79.95 �
Update by Teletext or Internet £119.95 �
Update using Prestel Citiservice (OCHLV) £159.95 �
2,700 price histories Free

Updates
Internet Data Service Free �
Data Service Diskette

Weekly (£ 3.50)          � Monthly (£ 7.00)    
�
25% discount if paid 6 months in advance  

�

Teletext adaptor card (Microtext/WinTV) Ask for
details

Annual Support and Upgrade Contract 
Order now and get two months extra FREE £49.95

Postage & Packing    £5.00

Total (Please add VAT ( at 17.5%) in the EC) 

Plese send to :
WinStock Software
10, Jewry Street
Winchester,      SO23 8RZ,    UK

Phone :        01962 715557      
Fax : 01962 863516      
E-mail : winstock@compuserve.com
Browse : http://www.winstock.co.uk

Your details :

Name:

Address:

Country:

Phone Number / E-mail address:



Credit Card Number:        

Expiry Date (and issue number if applicable):          

Credit Cards Accepted: Visa, Mastercard, Access, Switch          

Please make cheques payable to: WinStock Software          

Please state how you would like to receive your data updates:    
1. By internet (an e-mail file will be sent to you, FREE of charge, each evening 

covering all UK closing prices with highs and lows where available)
2. By data service diskette, weekly or monthly. This covers the same prices as supplied 

by e-mail. Your archives will be brought back up to date with daily data.
3. By teletext adaptor (you will need an adaptor card for your pc - we can supply these 

please ask for details). 2,700 stock prices can be picked up daily from teletext in the 
UK with highs and lows where available.



The Analyst for Windows    --    Demonstration Guide

Introduction
Register for   FREE   daily email updates  
Setting Up
Commands and   Navigation  
Drawing a Chart
Working with Graphs
Analysis Techniques
Portfolios
Cash Account
Colour Data Imaging
Price Alarms
Exporting Data
Price Updating
Order the Program

WinStock Software
10 Jewry Street
Winchester
SO23 8RZ
 
Telephone :        (UK) 01962 715557      
Fax : (UK) 01962 863516      
E-mail : winstock@compuserve.com
Browse : http://www.winstock.co.uk



Introduction

The Analyst is a state of the art stock market price tracking, analysis and portfolio management 
system. This demonstration is a full working copy of the program. It comes complete with up-to-date price
data for 2,700 companies, currencies and indices and will run for 30 days from the day it is loaded onto 
you computer. To help you to familiarise yourself with the program, this manual outlines the basic 
features. A full help file is included with the program and is accessed by pressing any help button on the 
screen.

All updating functions are active and you may update the program during the trial period by teletext or by 
email. To update by teletext you will need a Microtext or WinTV card in your computer. To update by 
email, simply call us on 01962 715557 or drop a note to us at winstock@compuserve.com. Let us know
your email address and we will send you a price update file each evening. This service is free of charge 
during your trial period and remains free of charge even after you buy the program.

When you purchase The Analyst, your price histories will be extended to between 3 and 12 years and any
portfolio or transaction details you have entered will remain valid. The full package is supplied with a 
comprehensive user guide. 

The Analyst is a complete investment system. It will help you to invest and trade more effectively. It 
provides full and unrestricted charting, analysis, portfolio management and data acquisition for a one-off 
price.

Our after-sales support is an important feature of The Analyst system. We are always available by phone 
or e-mail to answer your queries or guide you through the program.

I hope you will agree with our many customers that The Analyst is an excellent investment. To purchase 
the program simply fill in the order form (from the help menu select "Order the full program") or call us on 
01962 715557. If you have any questions, please feel free to contact us.



Register for   FREE   daily e-mail updates during your trial period  

All updating functions are active during your trial of The Analyst. You may update the program during the 
trial period by teletext or by email. To update by email, simply drop a note to us at: 

winstock@compuserve.com 
or call us on: 

01962 715557 

Let us know your email address and we will send you a price update file each evening. This service is 
free of charge during your trial period and remains free of charge even after you buy the program.



Setting up

Follow the instructions below to install The Analyst on your computer. The Setup program installs The 
Analyst, the help system and other product components from the distribution disks to your hard disk. The 
demonstration program includes sample data sets and portfolios.

Hardware and System Requirements

Any IBM-compatible PC with a 386 processor or higher.
Windows version 3.1 or later.
8 MB or more of RAM, a hard disk and a mouse.
Allow at least 10MB of hard disk space for installation.
Any monitor and printer supported by Windows.

 

To start setup
Insert Diskette 1 in drive A.
For Windows 3.1, 3.11 and Windows NT

From Program Manager choose File/Run.
For Windows 95/98

Click on Start and then Run.
Type a:setup and follow the setup instructions on the screen.

A program group or folder will be created. To activate the program, double click on the Analyst icon.



Drawing a Chart

Several methods may be used to produce a price chart. The easiest is simply to double-click on a share 
name. To display share names use either of the following procedures:
 
a. The Archive Browser 
Activate the archive browser using the toolbar button pictured above    or select file/chart from the menu. 
A dialog box will be displayed. Type in the first few letters of a share name. The program will search the 
archives and display all matching entries. Select the correct name from the browse list and press OK to 
view the chart.

b. The Portfolio Manager 
Load the portfolio manager by pressing the toolbar icon shown above or by choosing file/portfolio from the
menu. Select any portfolio listed in the dialog box which is now displayed. Press OK to list the portfolio 
contents. Finally double-click on any share in the list to see its graph.

Changing the time scale - Zooming in and out



Working with Graphs

Trend Lines
Draw any number of free form lines on a chart. Click on the free form line icon in the toolbar. Click on the 
chart where the line is to start, drag the pointer to draw the line. If the line needs to be moved, drag it 
from its centre. To rotate the line pick it up from either end. You can change the colour or style of the line, 
or delete it, by clicking on the line with the right mouse button and selecting from the popup menu. 
Best Fit Lines
Regression or best fit lines are drawn by clicking the best fit line icon and dragging a box from the start to
the end position of the line. The line is calculated and drawn inside a one standard deviation channel.
Fibonacci Fan Lines
Fan lines act as support and resistance for stock trends. Select Analysis/Fan Lines and draw the base 
line along an exiting trend. The fan lines will be drawn at set angles from the base line.    
Stop-Loss
Click on the stop-loss icon and select the percentage stop-loss you require. Click on the chart to indicate 
where the stop-loss is to start.
Stop-loss lines indicate that a price reversal of a given percentage has occurred when it is crossed by the
price line.
Linear/logarithmic
Toggle between linear and logarithmic price axis using the lin/log icon. Logarithmic displays show 
percentage movements directly.
Moving Average
The MA icon loads the moving average dialog box. Moving averages smooth out price variations and 
show trends more clearly. Choose any period and select from centred, lagged, simple or exponential. You
may add percentage bands or bollinger (standard deviation) bands.
High/Low
Display the daily highs and lows on any linear chart
Candlesticks
Candlesticks show open/close information as a box (blue for rising, red for falling) with the day's high/low 
as a line extending above and below.
Saving Charts
Before unloading a chart, you will be prompted to save any changes.



Analysis Techniques

Price plots for different companies may be displayed together on one chart to make a direct comparison. 
Select a share from a portfolio or the archive browser. Drag it to an active chart and drop it in. Choose the
display format (Rebased, Relative and Absolute - see help file) and the two curves will immediately 
appear together in the same chart.

Any number of overlays, moving averages, stoploss, lines etc. may be drawn on a chart. To delete an 
object from a chart, select the object with the right mouse button and choose delete from the popup 
menu.

Any number of charts may be drawn and arranged on the screen. To delete all charts, select "Close All 
Charts" from the window menu.

The Analyst supports a variety of analytical techniques. Select a graph and choose an analysis type from 
the analysis selector (shown below). A dialog box will be displayed.    Fill in the details and press OK.

Indicators, such as MACD, Meisels, Momentum, OBOS, RSI or Stochastic, can be displayed either on a 
new analysis chart or overlaid on an existing one. The analysis chart will be drawn below the price chart. 
Both charts will rescale and resize together. 

Analysis Selector

Analysis Menu



Templates
Any combination of indicators, trend lines, time scales, stop-losses etc. can be stored as a template to be 
applied to another security. Use File/Templates/Save to store an analysis type. To apply this to any other 
share, load the share chart and select File/Templates/Load.



Portfolios

The Analyst will maintain any number of portfolios. 

Portfolios may be displayed as simple share listings showing, for example, the latest price or the high or 
low for the day.    

 By pressing the portfolio toggle button on the toolbar, the listing will expand to show a full portfolio 
summary detailing holdings, values, gains and totals. Transaction and dividend details may now be 
entered and valuations will be continuously updated as prices are received.

Viewing a portfolio
Select the portfolio manager icon  from the toolbar or, from the File menu, choose Portfolio. A 
dialog box will be displayed.
Select a portfolio.
Press OK and the simple portfolio listing will be loaded. 

Viewing a full transaction summary

Activate your portfolio. Press the portfolio toggle button  on the toolbar or choose View Portfolio 
from the Display menu, to switch between the simple listing and a full transaction summary.

Creating a new portfolio
Select the portfolio manager icon  from the toolbar or, from the File menu, choose Portfolio. A 
dialog box will be displayed.
Select New and type in the name of the new portfolio. 
Press OK and the new portfolio list box will be loaded.

Adding shares to a portfolio
Activate your portfolio. 
Load the archive browser by choosing Browse from the File menu. A dialog box will be displayed. 
Type in the first few letters of the share name. The program will search the archives and display all 
matching entries. Select the correct name from the browse list.



 
Price Updating

Prices histories may be kept up to date in a number of ways.    Internet, teletext and diskette updating are
all compatible and maintain closing prices, with highs and lows where available, for about 2,600 shares, 
currencies, indices, commodities and gilts.    Updating from Prestel Citiservice provides Open, Close, 
High, Low and Volume figures for all 3,500 shares quoted on the London stock exchange. Portfolio 
valuations and graphs will reflect the latest data available to your system.

Before updating for the first time ensure that the Update Method in the Option menu is set to whichever 
method you are using.

a. Internet Feed
The internet feed consists of closing prices for all shares, with highs and lows where available. The file 
will be sent to your E-Mail address each evening, free of charge. Once you have received the file The 
Analyst will quickly add its contents to your archives. Select File / Update and press OK.

If you are not on the internet but would like to receive this feed, we would be happy to advise.

b. Teletext Operation
To use this option you will need a teletext adaptor card installed in your PC. The Analyst works with 
Microtext, Optimum and the full range of Hauppauge WinTV cards including the WinTV-PCI card.
Data for over 2,600 companies, currencies, indices etc. will be captured automatically. If a new company 
is encountered, a new data set will be started without user intervention. Price data is first captured and 
then, at the end of the day's trading, added to the archives.

Microtext or Optimum
If you have a Microtext or Optimum card you will need to tune it from the Analyst before using it with 
the program for the first time. Open the Analyst, select Teletext / Tune and follow the instructions.

Hauppauge WinTV (Celebrity, Cimema Pro, Prism, WinTV PCI etc)
If you have a WinTV card you will need to tune the channels in order (BBC1, BBC2, ITV and CH4). 
Do this from the Hauppauge TV program by selecting Configure / Channels. 

Teletext Data Capture 
Select Teletext/Capture to switch capture on or off. Data Capture is controlled by Page Lists in the 
teletext menu. Adding data to the archives is automatic. A timer located in the options menu will 
ensure that updating is not forgotten.

c. Data Service Diskette
If you choose this method, let us know how often you wish to receive an update. The diskette will contain 
daily closing prices for all shares, with highs and lows where available, covering the period since your 
last update. The process of updating several thousand data sets is fast and simple. Insert the diskette 
and select File / Update.

d. Prestel Citiservice
Prestel supplies OCHLV data for 3,500 shares, gilts etc. available from 6.30 pm each evening. Up to 20 
days of zipped up back data can be downloaded in one session from Prestel's dial in bulletin board. 
Downloading and unzipping can be performed using Prestel's own program or using your own comms 
package and unzip utility. The Analyst will process any number of days of back data with a single 
command. The Prestel version of The Analyst will record all OCHLV information, displaying volume pips 
on price charts, OCHLV histories etc. Prestel can be contacted on 0171 591 9008.

e. Manual Input
Current Data : Activate your portfolio and click the right mouse button over the share in question. Select 
Manual Input from the popup menu and key in the share prices. Use the next/last buttons to enter prices 
for other shares in the portfolio. When you have finished entering data select File/Update to bring your 



archives up to date.

Historic Data : Position the mouse pointer over the share in question and press the right mouse button. 
Select Price History from the popup menu and key in the share prices.



 



Point And Click : Move the mouse pointer over an object or text. Press and release the 
mouse button. 
For example, position the mouse pointer on a chart and click. The date and price at that 
point are instantly displayed in the status bar. 



Drag And Drop : Move the mouse pointer over an object or text. Press and hold down the 
mouse button. Drag the object or text to its destination. Release the mouse button. 
For example, to compare two price plots in the same chart, drag a title from any listing onto 
a chart and drop. The two plots will appear together.



Toolbar : The toolbar is positioned just below the menu. Icons on the toolbar provide quick 
access to the more frequently used functions.



Menu System : The menu system is located at the top of the screen. It provides access to 
all WinStock functions. The choices displayed vary according the type of window that is 
currently active.



Base Curve : The Base Curve is the first curve drawn on any chart. The title of the chart is 
taken from the name of the base curve.






